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GEOG 487 Lesson 1: Step-by-Step Activity 

Part I: Esri Resources 

Successful GIS professionals teach themselves how to use new technology tools quickly, integrate 
technical resources other than ArcGIS software, and know how to troubleshoot when problems 
arise.  The secret to success is to know where to find help and educational materials.  This lesson will 
help you sharpen and expand your toolkit.  Watch out, you just may turn into the office hero that 
magically solves all of the complex technical problems. 

1. Explore Esri’s ArcGIS Resource Center 

a. Visit Esri’s Resource Center by clicking on the following link: 

http://resources.arcgis.com.  

b. The Resource Center’s Help Section is a great place to find conceptual information and 

step-by-step instructions on how to use particular tools.  Topics are well organized and 

easy to find.  Most articles contain links to similar topics; if you follow the links you can 

find a plethora of information related to your topic or question.   

c. If you have a specific question or article you want to find, the easiest method is to use 

the search tool available on the top right corner of the page.   You can narrow your 

search results by clicking on any of the filters that appear on the left side of the page. 

d. We are going to use a variety of GIS tools in this course, some of which you may be 

familiar with and others, which may be completely new to you.  Quite often the lesson 

text will not provide detailed instructions on how to use tools that were covered in 

previous lessons or courses.  The Resource Center is a great way to refresh your 

memory about what certain tools do, how to access them, and how input parameters 

affect the outputs (e.g. cluster tolerance).   

e. Try searching for the conceptual help topics below at http://resources.arcgis.com.  

• “A Conceptual Model for Solving Spatial Problems”  

• “An Overview of the Spatial Analyst Toolbox”  

 
NOTE: The articles will be listed in an archived version of their site because they refer to 

a previous version of ArcGIS (10.1).  Most of the time help articles from previous 

versions will still be relevant, as Esri rarely redesigns their software interface or 

workflows. 

 

f. If you don’t have a specific question in mind, browsing through the help articles using 

the navigation window is a great way to learn about new tools and techniques.  The 

http://resources.arcgis.com/
http://resources.arcgis.com/
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topics are grouped into folders that allow you to browse through many related articles.  

For example, there are descriptions of all of the spatial analyst tools grouped by 

functionality.  Many of these functional groups are related to environmental topics.    

g. Go to the main help page http://resources.arcgis.com/, then click on the “Help” tab. 

Click on the small text that says “10.5,” after the words “ArcGIS Desktop,” then click on 

the “Tools” tab as shown below. 

 
h. Try navigating through the help topics to find the articles related to the “Groundwater 

toolset,” “Hydrology toolset,” and “Solar Radiation toolset” within the “Tool Reference” 

drop down menu on the left side > Spatial Analyst Toolbox. 

i. Browsing through the help topics may give you some ideas about how you can use GIS 

to address other environmental questions or tools not covered in this course.  I find the 

following particularly helpful for this purpose: 

• Scroll back up to the top of the main page, then Analyze Tab > Commonly Used 

Tools > An introduction to the commonly used GIS tools 

• More Tab > Perform analysis >About performing analysis with the Spatial 

Analyst extension (all topics) 

j. If you are having trouble with a particular tool, consider looking in the tutorials section 

for additional help. Skim the material (you don’t need to complete the actual exercise). 

 
 

  

http://resources.arcgis.com/
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2. Explore Esri User Forums (GeoNet) 

a. GeoNet is a great place to look for answers related to specific technical issues such as 

how to interpret error messages.  If you can’t find an answer to your particular question 

by searching the existing posts, you can always add your own.   

b. Esri employs several people who monitor the forums and respond to your questions.  

c. You can find posts by typing a topic in the search box at 

https://geonet.esri.com/welcome.  

d. Scroll down the page and check out the communities and topics posted (You need to log 

in and request access to actually view the material.  If you don’t already have an Esri 

access account, you can skip this section.  We’ll be creating a new account with 

particular criteria later in the course.  The important part is you know this resource is 

available).  Once you have an account, you can use the search tool for broad topics like 

“Spatial Analyst” or more specific questions like error message codes “error 999999.”  

This is handy when you are mid-project and receive a strange error message you don’t 

know how to interpret. 

 

3. Explore ArcGIS Online and Esri Apps 

a. We’ll use ArcGIS Online extensively in this class to share our analysis results and data.   

b. Watch the short overview video at http://www.arcgis.com/features/index.html. 

 
 

c. Esri also offers many specialized apps that work in unison with ArcGIS Online.  

d. Read about the available options at http://www.arcgis.com/features/apps/index.html. 

e. If you have time, explore one or more of them in depth.  Some of my favorites are 

Collector for ArcGIS (field data collection), Esri Maps for Office (easy geocoding and heat 

maps in Excel), Story Maps & Web Application Templates (out-of-the-box interactive 

maps) and Operations Dashboard for ArcGIS (real-time data gauges and stats). 

That’s it for Part I.  In Part II, we will explore some additional tools offered by other 
organizations. 
 
  

https://geonet.esri.com/welcome
http://www.arcgis.com/features/index.html
http://www.arcgis.com/features/apps/index.html
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Part II: Other Resources 

1. Explore Google Earth Application 

 

a. Google Earth is a free application that enables you to view, interact with, create, and 

share geographic information in 3D. Go to the Google Earth homepage at:  

https://www.google.com/earth/. Much of the Google Earth content is now available 

directly via web browsers, which you can access through the “Launch Google Earth” 

button. However, many additional map layers, images and videos, and functionality are 

available in the downloadable version. Click the “Older Versions” link at the top of the 

window and download Google Earth Pro. 

 

b. Watch the "Beginner Tutorials" videos and Feature Tour located within the “Learn” link 

highlighted below. (The Learn Link is: https://www.google.com/earth/learn/)  

 
c. Google Earth Pro has many helpful features that compliment ArcGIS software.  For 

example, you can use it to familiarize yourself with a new study area.  There are several 

layers that allow you to interactively explore 3D panoramic videos of a location, such as 

the Street View layer shown in the graphic below.  (To switch to Street View, zoom in to 

a location of interest and drag the orange man icon in the top left corner onto the map). 

d. Other similar layers are available under the “Gallery” heading, such as “360Cities”, 

“Gigapan Photos”, and “Gigapxl Photos.” 

  

https://www.google.com/earth/
https://www.google.com/earth/learn/
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e. Open Google Earth and browse through the available layers. 

 

 
 

f. Many agencies and organizations create data for Google Earth, such as NASA, National 

Geographic, and the World Wildlife Fund (WWF).  These layers are available under the 

“Gallery” and “Global Awareness” headings.  Typically, the data are shown as point 

icons.  When you click on the icon it opens a popup window with pictures and more 

information about the subject.  

g. Google Earth also has many tools to easily create new geographic content.  You can see 

quick descriptions of all of the available tools by hovering your mouse over the toolbar 

along the top of the screen.   

 

 
h. Briefly experiment with the tools we covered.  For example, you can try to toggle 

between Street View and the default view and create a new polygon on your map.   
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2. Explore Screencast-O-Matic 

 

a. Screencast-O-Matic (https://screencast-o-matic.com/) is a free software program that 

enables you to record videos of your screen and audio through your microphone.   

b. In addition to using this tool in your lesson assignments, a possible application 

Screencast-O-Matic is to visually demonstrate a problem you are experiencing in the 

class.  It is much easier for me to help you with problems if you create a video of the 

steps that lead up to an error on your own machine. You can upload your video to Box 

(box.psu.edu) and post a link to it on Piazza to get troubleshooting advice from 

instructors and fellow students.   

c. Watch some of the videos on the Tutorials page. 

d. From the Screencast-O-Matic home page, click the Start Recording button to begin. Use 

the Launch Recorder button on the next page to set up your recording. We will only use 

the free version in this class; please don’t use the Pro option, which requires a paid 

subscription. 

e. To share your video: 

i. Save your recordings as MP4 video files on your computer. 

ii. Go to box.psu.edu and log in using your Penn State User ID and password. 

iii. Click the Upload button and browse to the .mp4 file on your computer you want 

to share  

iv. Once your video has uploaded, click Share and set it to share with People with 

the link. 

 
v. Copy that link and paste it in your Piazza submission for the assignment. 

 
  

https://screencast-o-matic.com/
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3. Explore Prezi 

a. Prezi (http://prezi.com) is an online software presentation tool that mimics some of the 

features of GIS (like the ability to zoom and pan).  It is a great resource to share GIS 

project plans or results with teammates or clients.  

b. You will be required to create a Prezi Presentation as part of the Final Project.  I 

recommend you spend additional time exploring this software over the next few 

weeks to avoid last minute stress during the final.  There is a bit of a learning curve to 

mastering the program, but the effort is worth it. 

c. Review the content on the homepage to get an overview of the tool.  Prezi just released 

a new version of their product called Prezi Next.  You can choose to use Prezi Classic or 

Prezi Next for this class. 

f. Watch the three short overview videos of Prezi Classic at https://prezi.com/support/.  

This page contains links to help articles you may want to refer to later on.  There is also 

a support page for Prezi Next: https://prezi.com/business/support/.  

 

 
g. Get inspired by viewing a few sample presentations at https://prezi.com/gallery/.  

h. There are multiple license types available.  We will use the free educational version.  Go 

to https://prezi.com/pricing/ click on “Students and Teachers > Educational Plans > Edu 

Standard” option, then “Choose Plan.”  Follow the instructions provided by Prezi to 

complete your enrollment.  Make sure to use your Penn State email account since you 

need to have an email ending in “.edu” for this license. 

i. Log in to your account and click “Create a New Prezi.”  

j. Add a title and description, then click “Create new prezi.” 

k. Note: Prezi redesigned their user interface during the last year.  You may see references 

in some help material referring to the old design. 

l. Browse the available presentation templates.  Click on your favorite and then click “Use 

Template.” 

http://prezi.com/
https://prezi.com/support/
https://prezi.com/business/support/
https://prezi.com/gallery/
https://prezi.com/pricing/
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m. Experiment with editing the template for 5-10 minutes (e.g. try to edit some of the text 

boxes, zoom in and out, and pan around the screen).  When you are finished, click on 

the X button to exit. 
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4. Explore Symbology Selection Resources 

 

a. The Color Brewer website at http://colorbrewer2.org/ is a very useful tool to help you 

choose symbology that will best communicate trends in your data.  It was designed by 

Cynthia Brewer and Mark A. Harrower from Penn State.  

b. Click on the “i” links under each section for information about how to use the site. 

 
c. Many environmental data sets are typically symbolized in a quasi-standard manner.  For 

example, rivers are usually shown as blue lines and topographic lines are usually shown 

as brown lines.  Land use/land cover, geology, and wetland features are other examples.  

Since most people are accustomed to seeing this data symbolized a certain way, your 

map could be confusing if it doesn’t follow these “unspoken” rules.  What would you 

think if someone handed you a map with forests shown in yellow, wetlands shown as 

purple polka dots and rivers as red dashed lines?  

d. You can find information about standard colors for different industries by searching on 

the Internet.  Here is a helpful overview article about the role of color in maps: 

http://geography.about.com/od/understandmaps/a/mapcolors.htm.  

 

  

http://colorbrewer2.org/
http://geography.about.com/od/understandmaps/a/mapcolors.htm
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5. Explore Unit Conversion Tools 

 

a. We will need to convert units in many of the lessons.  There are tools within ArcGIS that 

can assist in this process.  It’s also helpful to use online resources such as: 

i.  Google  

1. You can type a simple request into the Google Search box like, “Convert 

34 meters to feet.” 

ii. www.onlineconversion.com. 

1. This website allows you to enter your starting value and units and 

convert it to pretty much any unit you can think of by clicking a button. 

 

 

That’s it for the required portion of the Lesson 1 Step-by-Step Activity. Please consult the Lesson 

Checklist for instructions on what to do next. 

 

 

Do you know of another helpful GIS resource not covered in the lesson? Write a brief 
description (less than 100 words) of the resource or tool and post in Canvas Lesson 1 
Discussion. 

Note: Try This Activities are voluntary and are not graded, though I encourage you to complete the activity.    

 

 

http://www.onlineconversion.com/

